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Chapter 1. Categories

1.1. Category

A category is a means to group your events or other categories together. In Indico ’Home’ is the top level
category in which you start from. Inside a category you can add events or other subcategories, set access
rights to say who can access or modify, re-allocate the sub- categories, remove the sub-categories and
also delete the current category and everything it has inside it. These features are accessible through
’modify’ (if you have modification rights) on the Tools menu inside the category. You will then be in the
Management Area for Category.

1.2. Creating a Category

From the Management Area you can create a new category you will need to have an administrators
account or be listed in the modification list (See Access Control) for the category. Inside the main tab
(See Main) in the management area you have the option to ’add sub-category’ from there you will need
to fill in details for the new category. Your new category will then be created.

1.3. Category Management Area

1.3.1. Main

From the main tab in the Category Management Area:
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Chapter 1. Categories

You can modify the details of the category; including the default styles for meetings and lectures within
the category (See Meetings or Lectures). You can also add, remove and re-allocate events or sub
categories.

1.3.2. Access Control

From the management area you can protect your category using the 3 controls for access levels:
Modification Control, Access Control and Domain Control. You can add Users or Groups to the
Modification and Access Control lists.
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Chapter 1. Categories

Modification ControlCategory Managers can be added to a category to allow access to the management
area for modification. Category managers are either those listed in the modification control list, or
administrators. The creator of a category will be able to modify it without be listed.

Access Control A category can be public or private; Public: Any body can view a public category and
any user can add events to it. However users will only be able to see the events inside the category to
which they have access to. Private: Only those users in the access list or administrators can access the
category and add events. When a Category is made private, the option for domain control is omitted and
any event or category made inside will also be private. The category will be displayed with "(protected)"
after its name to show it is private.

Domain Control - Access to a category can be defined by IP addresses in a domain. A domain needs to
be created from the Admin tab of the Tools menu before you can add them to the access list.

1.3.3. Conference Creation Tool

In categories other than ’Home’ you have a tab called ’Conference Creation Tool’, from here you can
restrict who is able to add events to the category. If you restrict it then you need to add users to the list to
allow them to add events.

1.3.4. Detail Modification & Sub-Category/Event Organisation

The details of a Category can be modified and sub categories can be organised from the main tab in the
management area. Details can be modified by clicking on modify inside the main tab. Sub-categories and
events can be organised in the particular order you wish to view them by using the order drop down box
next to each sub-category.
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You can re-allocate a sub-category or event by selecting the one you wish to move using the tick box and
clicking on re-allocate, you will then be asked where you would like to reallocate this sub-category/event
to. To remove a sub-category or an and anything it contains or an event select it and click remove, if it
contains anything you will be asked if you are sure you want to delete.

1.3.5. Deleting a Category

To delete the current category you are in you can go to the Tools tab in the management area and select
’Delete this category’ you will be asked to confirm the deletion first.
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Chapter 2. Conferences

2.1. Conference

A conference is the most comprehensive event in Indico. You can create tracks in which
you can call for abstracts to be submitted; these abstracts can then be accepted and become contributions
in your conference. A timetable can be created which can include many sessions; these sessions can be
split into slots if you need to further divide the session. The sessions and slots can contain contributions
or you can directly have a contribution in the timetable. Contributions can have sub contributions.
Material for example papers can be added to these contributions, sub contributions, sessions and directly
to the conference.

2.2. Creating a Conference

If a category is public or you have access rights to it you can create a conference in this category. To do
this click on ’Conference’ under Add Event you will be presented with a form in which you need to fill
with the details of the conference you wish to create. Once this is done your conference will be created.
The creator of this conference will by default have modification rights to it and is referred to as a
Conference Manager as is anyone else listed in the modification access control list.

To access the Management Area of a conference you need to click on the modification icon next to the
Conference Name.

2.3. Setting up a Conference

Once your conference is created the Conference Manager can start setting up the conference from the
Management Area -

• Set up your Access Control to restrict or allow users the rights to access or modify the conference.(See
Access Control Management).

• Start adding Tracks to your conference to define areas to help with organisation, a Track Manager can
be assigned to each track to co-ordinate which abstracts to accept into these tracks (See Program
Management).

• Start calling for abstracts. Abstracts are proposed contributions to your conference. By default when
you first create a conference calling for Abstracts is disabled. You can enable this in ’Abstracts’ (See
Abstracts Management)

• Start looking at which submitted Abstracts you wish to accept into your conference, they will then
become contributions (see Contributions Management).
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• Start setting up a Timetable to organise what will be happening where and what contributions,
materials etc will be included (See Timetable Management).

• Look at customising the look of your conference when users come to view it (See Display
Management)

• If those that will attend your conference need to register and give details concerning their needs while
at the conference, you can set up a registration Form (See Registration Management)

• There are options to make offline versions of your conference, to clone your conference and to perform
other tasks on the whole of your conference once you have one set up. (See Conference Tools).

2.4. Conference Management Area

The Management Area allows you to control the different parts of your conference the following sections
will show each area of the Conference Management.

The frames surrounding each management area, give you access to either the modification area above or
to a display of that area.

Clicking on the left hand icon will take you to the Display area for the area you are on, e.g.
contribution (See Contribution Diplay).

Clicking on the name of the event or contribution etc will take you directly to the management area for
the event / contribution.

2.4.1. Main Management

From within the Main Tab you can (Some parts of the screen may not be visible in the pictures):
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• Modify the general information of the conference, e.g. name, Description, dates etc. The Support
email if you supply one will be the support email linked from the bottom of the Display Menu , in the
Conference Display Area (See Conference Display).

• Add or remove chairpersons to/from the conference

• Add or remove Material (See Material)

• Create a type of contribution for your conference, for example, oral presentation. This contribution
type can be chosen for any abstracts or contributions added to the conference.

• Close the conference from the status area which means it is over, it cannot be accessed by anyone once
it has been closed.

2.4.2. Program Management

From the program tab you can add / remove tracks and access each of the tracks (See Tracks below)

7
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2.4.2.1. Tracks

Tracks are parts of the conference in which abstracts and contributions can belong to. Inside those tracks
you can do the following things:

• Main - Modify the Code; a code can be used if you prefer to use codes as apposed to using long titles.
The Title and the description can also be modified.

• Coordination Control - Assign ’Track Manager(s)’ to the track who can decide what is accepted into
their track. A Track Manager does not have modification access to the rest of the conference, they have
access only to the modification of their Track.

8
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• Abstracts - Show any abstracts which have been submitted into the track, the Track manager can then
propose to accept or reject it. Only the Conference Manager can have the final say in whether an
abstract is accepted / rejected. (See Abstracts Management)

• Contributions - Show any contributions that belong to that track (See Contributions)

2.4.3. Contribution Management

The Contributions Tab shows all the contributions in the conference these may have come from either
accepted abstracts or added by the conference mangers.

From the contributions tab you can:

• Create new contributions

• Access Contributions (See Contributions).

• Search for certain contributions

• Move contributions

• Create a PDF of contributions

• Show the authors of contributions

• Create a zip file of material from contributions

9
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• Create a zip file of all the proceedings.

2.4.3.1. Contributions

Each contribution has its own management area, (Some parts of the screen may not be visible in the
pictures).

From inside the Main tab you can:

• Modify the main details of the contribution for example, name, duration etc.

• Change which track this contribution is assigned to.

• Change which session this contributions is included in (See Timetable Management).

• Add / change authors and co-authors.

• Add / change the presenters of the contribution.

• Add Material to the contribution and access the material (see material).

• Withdraw the contribution from the Conference.

From the subcontributions Tab you can:

10
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• Add / Remove a sub contribution.

• Change the order of sub contributions by using the drop down priorities.

• Access each sub contribution (See sub-contributions).

From the Access Control Tab you can:

• List the users that can submit material into the contributions (See Material).

• List the users that can Modify the contributions

11
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• Make the contribution Public or Private: Public: Any user can view the contributions. Private: Only
users listed in the access / modification / submission control can access the contribution.

• List the domains that can access the contribution (only available if contribution is public)

From the Tools tab you can:

• Delete the Contribution

• Move the Contribution

• Write the minutes for the contribution, these will be attached to the material for the contribution (see
Material).

2.4.3.2. Sub Contributions

Sub Contributions can be added to contributions to organise the contribution further.

12
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From inside each sub contribution you can modify the general details, add or remove presenters and
attach material the same as you can for contributions. From the Tools tab in a sub contribution you can
delete that sub contribution or write the minutes for it, these will be attached to the material for the sub
contribution.

2.4.3.3. Material

Material can be submitted by a user once their abstract has been accepted and made into a contribution.
Material can also be added by the Conference Manager into the conference directly, or into a
contribution or sub contribution. From inside a contribution, you can add - General Material, Slides,
Videos, Minutes or Papers.

Within each of those types you can add files or URL links as the resources for these materials, you can
also modify the general details for the material.

When you add a paper, the main resource for that paper will show in the proceedings document you can
create from the contributions tab in the conference. For each material access rights can be set, from
inside access control you can list those users that can view the material.
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2.4.4. Abstracts Management

The abstracts Management in Indico is in three parts - Calling for Abstracts, the Abstracts themselves
and the Book of Abstracts.

2.4.4.1. Calling for Abstracts

The call for abstracts needs to be enabled first from the ’Call for Abstracts’ tab. From here you can set
the submission dates and the deadline for any abstract submissions. You can also add any
announcements. If you want to allow any users to make submissions after the deadline you can give
those users access to do so.

2.4.4.1.1. Notification Template

When a user submits an abstract they will receive an email letting them know the abstract has been
submitted successfully. You can customise this email by adding your own Notification Template. If you
do not create a notification template a default email will be sent. You can include in this template
information about the conference or the abstract for example the conference title, to do this insert

%(conference_title)s

in place of where you would like the conference title to be. The tags available to put in your template are
listed in the ’Available Tags’ box.
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2.4.4.2. Abstracts Tab

The Abstracts tab shows all the Abstracts that have been submitted to the conference:
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From the abstracts tab you can add new abstracts, create PDFs of the abstracts, create an XML file of
abstracts and get the authors list. You can also access each abstract; an abstract can be in one of 10 states:

Accepted Rejected Proposed Rejection

Withdrawn Merged Submitted

Under Review Duplicated Proposed Acception

Conflict

2.4.4.3. Abstracts

An abstract is can be either submitted by a user or manually added by a track manager. Once a abstract is
accepted it is automatically changed into a contribution and added to the contributions list in the
conference (See Contribution Management).
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The Conference manager from inside Abstract Management can change the status for example by
accepting it or marking it as a duplicate.

The main details of the abstract can be modified and the track to which it is associated with can be
changed as well as the user that submitted it. Any comments made by the Track Manager or Conference
Manager while changing the status of the abstract can be viewed from ’Track judgement’

Internal comments can be made, and a notification log can also be viewed from inside the abstract
management.

17
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2.4.4.4. Book of Abstracts

The ’Book of Abstracts’ tab lets you add any additional comments that you would like to appear in the
book of Abstracts, this is a PDF file which can be generated from the conference display (See
Conference Display) containing all the abstracts.

2.4.5. Timetable Management

From the timetable tab in a conference you can organise your conference. When you start with a
timetable it will look like this:

You can modify the start and end dates of the timetable, and you can start adding sessions, breaks and
contributions to your timetable.
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2.4.5.1. Sessions

A session is essentially a time slot to organise your conference with, one way can be to use a session for
each track. There can be more than one session happening at once for example different parts of the
conference can be happening at the same time but in different rooms. A session can also be split into
slots however these are optional, they can be used when the session takes place over more than one
period of time, for example you may have a morning slot then a break and then an afternoon slot within a
session or one day you have a session on a particular subject for a couple of hours and then two days
later you have another session on that subject, this can be done using slots.

2.4.5.2. Adding Sessions and Breaks to Timetable

To add a session to your timetable, use the ’new session’ button at the top of the timetable, this will
present you with a form to fill in with the details of your session.
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You can use the ’update parent’s dates’ option if you need to change the times of the timetable to
accommodate your session times.

Once the session is created it will appear in your timetable. The same procedure is followed to add a
break by using the ’new break’ option. You can then modify the session by clicking on the session name
this will take you to the timetable tab within the session (see Session Management). If you just want to
quickly change the location or time of an entry in the timetable you can use the modification icon next to
the name.

2.4.5.3. Adding Contributions to Timetable

To add a contribution to your timetable use the ’add contribution’ option this will take you to a screen
where you can select the contribution(s) you want to add.
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Once the contribution is added to your timetable you can click on the contribution name to edit the time
and duration of it within the timetable.

You can remove sessions, breaks and contributions by clicking on remove / delete in the top right corner
of each block. You can also move sessions to another starting date / time if needed.

2.4.5.4. Session Management

From the timetable tab in Session you can: Add slots to the session, Edit slots inside the session, Delete
slots inside the session, Add breaks and Add contributions.

2.4.5.4.1. Slots

A session can be split into slots (See Adding Slots to Session) however these are optional, they can be
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used when the session takes place over more than one period of time. A session is defaulted to having
one slot already when it is created.

2.4.5.4.2. Main Tab

From the main tab in session you can, modify the general session information, add conveners and add
material.

2.4.5.4.3. Contributions Tab

From the contributions tab you can see all the contributions that are part of your session. These
contributions will only be shown once they have been added (See Adding Contributions to Sessions).

2.4.5.4.4. Access Control

From the Access control tab in session you can set the access rights for modification, access and domain
control the same as you can for most of the conference; the only difference is the Co-ordination control
in which you can assign someone to be the co-ordinator which means they can add and remove
contributions and breaks to that particular session.

2.4.5.4.5. Tools Tab

From the Tools tab in session you can delete that session or write minutes for the session.

2.4.5.4.6. Adding Slots to Session

To add a slot use the ’new slot’ option this will take you to a form to fill in which will create your slot.
When you need to edit a slot use the ’edit slot’ this will take you to a screen with the options to change
times, titles etc.
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You also have the option to update the parent dates or to move the entries inside the slot. Update Parent
Dates allows you to update the session times if the slot will be outside the sessions original times. The
Move entries option means if for example you choose to make the slot an hour earlier, you can either
leave the contributions / breaks as they are or you can tick the box and move all the entries an hour
earlier too.
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These slots will appear in the main conference timetable like this:
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2.4.5.4.7. Adding Contributions to Sessions

To add contributions to a session you first need to import them from the main conference, to do this use
the ’contribution tab’ inside the session:

Click on ’import contributions’, this will take you to a screen where you can select the contributions you
want to include in your session.

Once you have selected the contributions they will appear inside the contributions tab in the session. You

25
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can then use the ’add contribution’ option from the session and select from the contributions you
imported. When you have added a contribution to your session/slot you can edit the times and duration
by clicking on the contribution name.

2.4.6. Access Control Management

Access Control in a conference is similar to that in a Category. There is Modification control, Domain
Control and Access Control. When adding to the Access and Modification lists, you can also add Groups
of users if any have been defined by Administration.

Modification Control Only the managers listed in the modification control, the creator of the conference
and any administrators can access the Management Area of the conference.However you can add a
Modification Key which means anyone with this key can modify the conference without logging in.
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Access Control When the conference is public - Anyone can view the conference including the
programme, timetable, abstracts etc. When the conference is private - Only those in the access list,
conference managers and administrators can view the conference.

When private you can also add an Access Key which means anyone with this key can access the
conference without logging in.

Domain Control This is not available when the conference is private, but when it is available it allows
you to specify which IP addresses can access the conference.

2.4.7. Registration Management

You may wish to have some kind of registration process for those attending your conference in which
you can give the registrants options of accommodation or any specific needs. The Registration
Management comes in two parts - the Registration Form and the Registrants.
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2.4.7.1. Registration Form

From the Registration Form tab you are able to firstly, enable or disable the Registration. You can also
modify the start/end dates of registration, the maximum number of registrants you will take, any
announcments and if you want to send email notifications to people when a new registrant applies.

You can choose which forms you wish to use for your registrants see the forms listed below, to enable or

disable one of these forms, click on the image next to that form, when it is red it is disabled and
green for enabled. Clicking on the form name will let you modify the form to allow the registrants to
enter the information you need (See Registration Area).

2.4.7.1.1. Reason for Participation

The Reason for participation form allows you to ask the registrant why they want to particpate, from this
form you can modify the question and title of the form.

28
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2.4.7.1.2. Sessions

The Sessions form allows you to add which sessions from your conference you would like people to
register for, from the form you can also change the title and description.

2.4.7.1.3. Accommodation

The Accomodation form lets you add or remove the different types of accomodation you can book your
registrants into or give them the choice to book their own.

2.4.7.1.4. Social Events

The Social Events form allows you to add / remove any social events that registrants can register on,
when you add an event you add the title you wish this event to have.
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2.4.7.1.5. Further Information

The Further Information form gives you the opportunity to add any additional information for the
registrants.

2.4.7.2. Registrants

The Registrants Tab will show a list of all the registrants that have registered for your conference.

Clicking on the registrants name will show you all their details and the information they provided in
response to the form’s questions.
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2.4.8. Display Management

The display area allows you to customise your conference, you can customise the menu that the will be
shown in the conference display (See Conference Display), change the colours of the conference
background / text and you can add a logo to your conference.
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2.4.8.1. Display Menu Customisation

The menu customisation allows you to activate or disable menu items and move them up or down the list.
You may add your own external links or just customise the already existing system links.

You can also add external links to your menu by using the ’add link’ option.
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If you want to add spaces between items in your menu you can use the ’add space’ option.

2.4.8.2. Colour Customisation

You can change the background colour of the conference by using the ’title background colour’ option.

The same can be done for the text colour by using the ’title text colour’ option.

2.4.8.3. Logo Customisation

If you want to add your own logo to the conference display you can add it from the logo area in display.
You can browse for you logo, save it, and see it in the preview box.

33



Chapter 2. Conferences

2.4.9. Conference Tools

The conference Tools allow you to make certain actions on the whole of the conference.

2.4.9.1. Deleting a Conference

The delete conference option will delete the whole conference. You will be asked to confirm deletion
first.
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2.4.9.2. Cloning a Conference

Clone the conference if you would like to make another conference the same, you have the option to
clone it just once, at fixed intervals or on certain dates.

2.4.9.3. Packaging Material

Using the ’Get material package’ option you can create a package of all the materials that have been used
in the conference.
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2.4.9.4. Create an Offline version of a Conference

Using the ’Offline web for your conference’ option you can create a copy of your conference that can be
used offline for example if you wish to store your conference to a dvd.

2.4.9.5. Alarm Control

You can set an an alarm / reminder to alert people about the conference, the alert will be in the form of an
email.
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This Conference Management Area explained can only be accessed by Administrators or
Conference Managers.

2.5. Conference Display Area

The conference Display is the view that users of the conference will see. If the conference is public they
will not need to login to view the conference. It is also the area in which you can access the modification
areas if you have access rights. The different areas of the conference can be seen using the left hand
Display Menu. This menu may be different if the Conference Manager has customised the menu. When a
conference is accessed the ’Overview’ area is shown first;

2.5.1. Navigating the Conference Display Area

Various parts of the conference display are always present in order for you to navigate or view the
display area:

This is placed at the top left of the display view and will take you back to the top level home category

This will be underneath the display menu and enables you to email the event support if
conference management have entered one
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This is placed at the bottom of all indico screens and enables you to
email the administrator if the administrator has entered the address.

This is on the top of the display menu and enables you close the view of the menu.

This is placed at the top right of the screen and is the access for logging in or out

The navigation bar, shows you were you are in the conference and
allows to back step through.

2.5.2. Overview Area

The Overview area shows the main details of the conference including any material that is included and
the date and location of the conference.

When an administrator or Conference Manager is logged in there will be a modification icon next to the
conference title for access to the modification area.

2.5.3. Calling for Abstracts Area

The call for abstracts view will show the range of dates in which an abstract can be submitted
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From within the Call for abstracts a user can submit an abstract and view the abstracts they have
submitted.

2.5.3.1. Submitting an Abstract

You need to be logged in as a user and the dates of submission must be in range to allow you to submit
an abstract. Once logged in you can fill in the form to submit your abstract. (Some parts of the screen
may not be visible in the pictures).
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You need to fill in the title, content and author details. If you need to you can add any co-authors. You
can also choose which track you would like your abstract to be included in as well as any comments you
would like to add. A notification will be shown to you if your submission was received.

2.5.3.2. Viewing your abstracts

Any abstracts you have submitted you can view and see their status. You can also create a PDF of your
abstracts. By clicking on the abstract name you will see the details of the abstract.

2.5.3.3. Abstract Display

When you click on an abstracts title you will be taken to the abstracts view, this shows all the details of
the abstract.

You can print the details of this abstract into a PDF using the icon in the top right corner.
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2.5.4. Author Index

The Author Index shows all the authors for contributions in the conference, the authors can be searched
for by name.

The contribution(s) (See Contribution Display) they have written and the details of the author can be
accessed by clicking on the name.

2.5.4.1. Author Display

The Author Display shows the details for the author e.g. contact details and the contributions they have
authored.

2.5.5. Contribution Area

Contribution List in the menu takes you to all the contributions in the Conference. From here you can see
a list of all or just certain types of contributions that you want to see for example only those contributions
in a specific session.
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You can access the display of each contribution by clicking on its name. You can also create a PDF of
either selected contributions or all of them.

2.5.5.1. Contribution Display

In the contribution display you can see all the details of the contribution, including the description, the
author, the session (if any) that it is included in, any material(See contribution material display) it has
and any sub contributions that belong to it. You can also access those details by clicking on their names.
You can also print the contribution in PDF, XML or ICal format by using the icons in the top right hand
corner.

If you have modification rights you will have the modification icon next to the print formats and you can
access the contribution modification area.
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2.5.5.1.1. Contribution Material Display

The material that belongs to a contribution can be viewed by accessing the material in the contribution
display. From the material display you can see the resources attached, and which contribution this
material belongs to.

When you first open the material display, if there is only one resource attached, that resource will be
opened e.g. If you have just the one link attached as a resource, when you access the material display the
url for that link will be opened.

2.5.6. My Conference Area

The ’My Conference’ area gives you access to those areas you have Co-ordinator modification rights to.
For example if you are a Track co-ordinator or a Session co-coordinator those tracks or sessions will
appear under my conference.

From here you can access your Tracks Modification (See Tracks) or Session Modification (See My
Conference - Session Co-ordination) by using the modification icon on the left of the title.
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2.5.6.1. My Conference - Session Co-ordination

The session Modification accessible from ’My Conference’ is slightly different from the Main Session
Modification as you are restricted to the Main tab and adding /removing contributions and breaks:

2.5.7. Registration Area

The Registration Area shows you the dates in which you are able to register, the max number of
registrants allowed and any contact information.
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2.5.7.1. New Registrant

From the new registrant area people can fill in the forms that were chosen and customised from the
Registration Management (See Registration Management).The registrant will need to fill in their
personal information and anything else in the form that has been asked for.
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Once submitted you will be shown a screen to confirm your registration.

The menu option which was ’new registrant’ will also change to ’Modify my registration’. This will
present you with the form you filled in originally and will allow you to change the information you
originally provided.

2.5.8. Book of Abstracts

The Book of Abstracts selection in the menu will produce a PDF document of all the accepted abstracts
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(abstracts that have become contributions) that are scheduled in the conference. It also shows any
contributions that are scheduled.

2.5.9. Scientific Programme Area

The Scientific Programme shows all the tracks with their descriptions:

You can create a PDF document of all the tracks using the PDF icon in the top right hand corner If you
are a Co-ordinator of any tracks, you will have the modification logo next to that track and a ’Manage my
Track’ option in the menu as in the picture above.

2.5.10. Timetable Area

The Timetable area shows all the session/slots, contributions and breaks for the conference. You can
access each session by clicking on the session name this will show you any contributions/breaks inside
this session.
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Clicking on a contribution name will take you to the display view of that contribution (See Contribution
Display) You can display the timetable for certain days or sessions and choose the detail level using the
display options you can also create a PDF of the timetable by using the icon in the top right hand corner

2.5.10.1. Session View

Session View allows you to see any contributions or breaks within each session:

If you are a Session Co-ordinator or a Session Manager you will have the modification icon in the top
right hand corner as above, this will take you to the appropriate Modification area for that session. You
may also make a PDF of the session.
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3.1. Meeting

A Meeting is not as in depth as a Conference and is made for smaller events. Within a
meeting you can create a Timetable in which you can directly add Sessions, Slots, Contributions and
Breaks. With a meeting you create the contributions as you add them to the timetable. You can set the
access Control for the meeting and you have Tools in which you can remove, clone, create offline
versions of the meeting and set alarms.

3.2. Creating a Meeting

If you have the correct access rights within a Category you can create a new meeting using the ’Meeting’
option in the Tools menu, you will be presented with a form similar to the one you would for a
Conference, however you are able to choose the default style in which the Meeting will be displayed
(See Meeting Display) when you submit this form the Meeting will be created.

3.3. Meeting Management Area

The Management Area allows you to control the different parts of your meeting the following sections
will show each area of the Meeting Management.

The frames surrounding each management area, give you access to either the modification area above or
to a display of that area.

Clicking on the left hand icon will take you to the management display area for the area you are
on, e.g. contribution or material etc (See Management Diplays).

Clicking on the name of the event or contribution etc will take you directly to the management area for
the event / contribution.
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3.3.1. Main Management

From the Main tab, you are able to modify the details of the meeting including title, description, location,
default style of the display.

You can also add / remove any chairpersons, add / remove material and close the Meeting, if you close
the meeting it can no longer be accessed.

3.3.1.1. Meeting Visibility

This option allows you to choose up to which level your meeting will be visible in the overview pages.

3.3.2. Timetable Management

The timetable management allows you to organise your meeting by using sessions, slots, adding
contributions and including breaks. When you first start to organise your meeting the timetable will look
like this:

50



Chapter 3. Meetings

You can modify the times in which the timetable will run between, this can either be the same as the
meeting or your own custom times:

You can add a break to your timetable using the ’new break’ option you will be presented with a form to
fill in with the details of the break you want to add.

3.3.2.1. Adding Contributions

You can directly add Contributions into your timetable using the ’new contribution’ option at the top of
each day; this will take you to a form to create a new contribution.
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Within this form, you can define the name, description, location, a board number and the starting time
with the duration in which you want this contribution to take place. If the contribution you want to add is
going to be outside the timetable times, you can tick the ’update parents dates’ and this will change the
timetable times accordingly.

If you want to change the location or time of the contribution you can use the modification icon on the
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left of the contribution, or you can click on the contribution name to go to the full modification area of
Contributions (See Contribution Management). You can also remove the contribution from the timetable
using the ’remove’ option on the right of the contribution name.

3.3.2.2. Adding a Session

To add a session to your timetable you can use the ’new session’ option, this will present you with a form
to fill in the details of your session:

As with the contributions you can choose to update the timetable dates if your session needs to be earlier
/later than the timetable is currently, using ’update parents dates’.
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Once your session is added to the timetable you can use the modification icon to the left to quickly edit
the basic details within the timetable or you can click on the session name and enter the main Session
modification area (See Session Management). You can also move or delete the session using the links on
the top right of the session block.

3.3.2.3. Session Management

From within session management you can organise each session. You can enter the session modification
from the session name inside the Timetable tab within the meeting management area. You are able to
add/edit/remove slots, add/remove contributions and add/remove breaks into the session from here. Slots
inside a session are optional, they can be used when the session takes place over more than one period of
time. When you create a session it is already made with one slot.
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The Session management shows the times of the whole session at the top. If you have slot(s) which take
up less time as in the picture above, (the session time runs until 12:00 but the slot finishes at 10:00) you
can use the ’fit to inner slots’ to make the session time start and finish at the same time as the first and
last slot.

3.3.2.3.1. Adding Slots to Sessions

To add a slot to a session use the ’add slot’ option, this will take you to a form to fill in with the slots
details:
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You can choose to update the sessions using ’update parent’s dates’ if the slot you are adding is going to
be outside the session times.
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3.3.2.3.2. Adding Contributions to Sessions/Slots

To add a contribution to the session use the ’new contribution’ option, this will take you to a form to
create the contribution, The form shows the name and time of the session or slot you are adding the
contribution to, and you can use the ’update parent’s dates’ if you need to change the times of the session
/ slot to accommodate your contribution.

When the contribution is added to the session or slot you can change the simple details i.e. time, location
by using the modification icon to the left, or you can click on the contribution name to go into the main
contribution management (See Contribution Managment).

3.3.2.3.3. Editing Slots

If you want to edit the slot details, i.e. change the time of the slot you can use the ’edit slot’ option this
will take you the slot modification screen:
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As before you can update the session times if the slot will be outside the sessions original times, you also
have the option to ’move entries inside slot’ this means if for example you choose to make the slot an
hour earlier, you can either leave the contributions / breaks as they are or you can tick the box and move
all the entries an hour earlier too.

3.3.2.4. Contribution Management

You can access the contribution management area by clicking on a contribution name from the timetable,
the following sections explain the management area of each contribution.
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3.3.2.4.1. Main Tab

From the main tab you can modify the main details of the contribution - title, description, location etc.
You can also change the session it is included in, add / remove presenters or add / remove material (See
Material in Contributions).

3.3.2.4.2. Sub Contribution Tab

From the sub Contribution Tab you can add/remove sub contributions:

Clicking on a sub contribution name will take you to the modification area for the sub contribution (See
Sub Contributions). You can also change the order of the sub contributions using the drop down priority
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list.

3.3.2.4.3. Access Control Tab

From access control you can add/remove users that are allowed to access, modify or submit into your
contributions you can also choose to make your contribution private.

Submission Control List the users or groups that can submit material into the contributions (See
Material).

Modification Control List the users or groups that can Modify the contributions

Access Control Make the contribution Public or Private, If Public: Any user can view the contributions. If
Private: Only users listed in the access / modification / submission control can access the contribution.

Domain Control List the domains that can access the contribution (only available if contribution is
public)
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3.3.2.4.4. Tools Tab

From the tools tab you have the option to delete, move or write minutes for the contribution.

3.3.2.4.5. Sub Contributions

Sub Contributions can be added to contributions to organise the contribution further, they can be access
from the ’sub contributions tab in each contribution (See sub contribution Tab).

From inside each sub contribution you can modify the general details, add or remove presenters and
attach material the same as you can for contributions. From the Tools tab in a sub contribution you can
delete that sub contribution or write the minutes for it, these will be attached to the material for the sub
contribution.
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3.3.2.4.6. Material in Contributions

You can add a variety of different materials to contributions, by choosing the type you want and clicking
on add, however you can only add one of each type of material but within these types you can add files or
links.

You can then enter the name and Description of the material. Once added you have the options to add
links or files to your material, one of these files/links can be classed as the main resource. You also have
an access control tab within the material for you to control who has access to view the material.

3.3.3. Access Control Management

Access Control in a meeting is the same as that in a Conference. There is Modification control, Domain
Control and Access Control. When adding to the Access and Modification lists, you can also add Groups
of users if any have been defined by Administration.

Modification Control Only the managers listed in the modification control, the creator of the meeting and
any administrators can access the Management Area of the meeting. However you can add a
Modification Key which means anyone with this key can modify the meeting without logging in.
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Access Control When the meeting is public - Anyone can view the meeting including the programme,
timetable, abstracts etc. When the meeting is private - Only those in the access list, meeting managers
and administrators can view the meeting.

When private you can also add an Access Key which means anyone with this key can access the meeting
without logging in.

Domain Control This is not available when the meeting is private, but when it is available it allows you
to specify which IP addresses can access the meeting.

Material Visibility By default a material will always be visible in the timetable, even if it is private (the
user will then be redirected to a login screen or access key prompt when clicking on it). You can force
the material to be hidden for non-authorized people by using the "Visibility to unauthorized users"
section in the material access control page.
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3.3.4. Tools Management

The meeting Tools allow you to make certain actions on the whole of the meeting.

3.3.4.1. Deleting a Meeting

The delete meeting option will delete the whole meeting. You will be asked to confirm deletion first.

3.3.4.2. Cloning a Meeting

Clone the meeting if you would like to make another meeting the same, you have the option to clone it
just once, at fixed intervals or on certain dates.
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3.3.4.3. Packaging Material

Using the ’Get material package’ option you can create a package of all the materials that have been used
in the meeting.
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3.3.4.4. Create an Offline version of a Meeting

Using the ’Offline web for your meeting’ option you can create a copy of your meeting that can be used
offline for example if you wish to store your meeting to a dvd.

3.3.4.5. Alarm Control

You can set an an alarm / reminder to alert people about the meeting, the alert will be in the form of an
email.

This Meeting Management Area explained can only be accessed by Administrators or Meeting
Managers.
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3.4. Meeting Management Displays

Using the icon as mentioned in the Management Area, you can display the item you are currently
modifying, this applies to material, sessions, contributions, sub contributions and the actual meeting. The
actual meeting display is what the user will be able to see when they access the meeting (See Meeting
Display Area).

3.4.1. Material Display

When going into the material display from the management area you will be shown all the links and files
that have been added to the material along with any details of the material.

If you have only one resource added it will open that resource, i.e if you have added just one url link
when you try to access the material display it will take you to that url. This Material Display can also be
veiwed from the Meeting Display Area that the user will see when viewing your meeting.

3.4.2. Session Display

When going into the session display from the management area you will be shown all the contributions
and breaks that have been added to the session.
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You can click on items within the session display to proceed to the management displays for those items,
i.e. each contribution. If a person is diplayed for example a convener clicking on their name will allow
you to email them.

3.4.3. Contribution Display

When going into the contribution display from the management area you will be shown all the details of
the contribution and also which session this contribution belongs to.

You can click on items within the contribution display to proceed to the management displays for those
items, i.e. the session it belongs to or any subcontributions that are under it.
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3.4.4. SubContribution Display

When going into the sub contribution display from the management area you will be shown all the
details of the sub contribution and also which contribution this sub contribution belongs to.

Any items in the Meeting Management Displays which have the modification icon diplayed next to
them allows you to go into the management area for that item.

3.5. Meeting Display Area

The Meeting Display is the view that users of the meeting will see. If the meeting is public they will not
need to login to view the meeting. It is also the area in which you can access the modification areas if
you have access rights. There are various views in which the meeting can be displayed, the following
sections show the different views and displays of the different parts of a meeting. If you have access
rights to view any parts of the meeting you can do so by clicking on their name, for example material
(See material Display).

3.5.1. Indico Style

This is the default view for meetings in Indico. If you have modification rights to any parts in the meeting

you will see the modification icon which will take you to the managment area for that item.
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3.5.2. IT Style

The IT style:
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3.5.3. Simple Text Style

The simple text style:
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3.5.4. Administrative Style

The Administration style:
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3.5.5. Compact Style

The Compact style:

3.5.6. Parellel Style

The Parellel style:
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4.1. Lecture

A Lecture is the simplest of events within Indico. A Lecture allows you to add material, give
details about the lecture and set the access control. You also have Tools in which you can remove, clone,
create offline versions of the lecture and set alarms.

4.2. Creating a Lecture

If you have the correct access rights within a Category you can create a new lecture using the ’Lecture’
option in the Tools menu, you will be presented with a form similar to the one you would for a Meeting,
you are able to choose the default style in which the Lecture will be displayed (See Lecture Display)
when you submit this form the Lecture will be created.

4.3. Lecture Management Area

The Management Area allows you to control the different parts of your lecture the following sections
will show each area of the Lecture Management.

4.3.1. Main Management

From the Main tab, you are able to modify the details of the lecture including title, description, location,
dates, chairpersons text and default style of the display.
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From here you can also add any chairpersons, add or modify material (see Material) or close the lecture -
closing the lecture will mean that it can no longer be accessed.

The frames surrounding each management area, give you access to either the modification area above or
to a display of that area.

Clicking on the left hand icon will take you to the management display area for the area you are
on, e.g.material(See Material Diplay).

4.3.1.1. Material

You can add material to the lecture, by using the ’add’ option in the material section, you can then enter
the name and description of the material.
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Once added you have the options to add links or files to your material, one of these files/links can be
classed as the main resource. You also have an access control tab within the material for you to control
who has access to view the material.

4.3.2. Access Control Management

Access Control in a lecture is the same as that in a Meeting. There is Modification control, Domain
Control and Access Control. When adding to the Access and Modification lists, you can also add Groups
of users if any have been defined by Administration.

Modification Control Only the managers listed in the modification control, the creator of the lecture and
any administrators can access the Management Area of the lecture. However you can add a Modification
Key which means anyone with this key can modify the lecture without logging in.
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Access Control When the lecture is public - Anyone can view the lecture . When the lecture is private -
Only those in the access list, lecture managers and administrators can view the lecture.

When private you can also add an Access Key which means anyone with this key can access the lecture
without logging in.

Domain Control This is not available when the lecture is private, but when it is available it allows you to
specify which IP addresses can access the lecture.

4.3.3. Tools Management

The lecture Tools allow you to make certain actions on the whole of the lecture.
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4.3.3.1. Deleting a Lecture

The delete lecture option will delete the whole lecture. You will be asked to confirm deletion first.

4.3.3.2. Cloning a Lecture

Clone the lecture if you would like to make another lecture the same, you have the option to clone it just
once, at fixed intervals or on certain dates.
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4.3.3.3. Packaging Material

Using the ’Get material package’ option you can create a package of all the materials that have been used
in the lecture.
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4.3.3.4. Create an Offline version of a Lecture

Using the ’Offline web for your lecture’ option you can create a copy of your lecture that can be used
offline for example if you wish to store your lecture to a dvd.

4.3.3.5. Alarm Control

You can set an an alarm / reminder to alert people about the lecture, the alert will be in the form of an
email.

This Lecture Management Area explained can only be accessed by Administrators or Lecture
Managers.
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4.4. Lecture Management Displays

Using the icon as mentioned in the Management Area, you can display the item you are currently
modifying, this applies to material and the actual lecture. The actual lecture display is what the user will
be able to see when they access the lecture (See Lecture Display Area).

4.4.1. Material Display

When going into the material display from the management area you will be shown all the links and files
that have been added to the material along with any details of the material.

If you have only one resource added it will open that resource, i.e if you have added just one url link
when you try to access the material display it will take you to that url. This Material Display can also be
veiwed from the Lecture Display Area that the user will see when viewing your lecture.

4.5. Lecture Display Area

The Lecture Display is the view that users of the lecture will see. If the lecture is public they will not need
to login to view the lecture. It is also the area in which you can access the modification areas if you have
access rights. There are various views in which the lecture can be displayed, the following sections show
the different views and displays of the different parts of a lecture. If you have access rights to view any
parts of the lecture you can do so by clicking on their name, for example material (See material Display).

4.5.1. Lecture Style

This is the default view for lectures in Indico. If you have modification rights to any parts in the lecture
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you will see the modification icon which will take you to the managment area for that item.

4.5.2. IT Style

The IT style:

4.5.3. CDS Agenda Style

The CDS Agenda style:
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4.5.4. Static Style

The Static style:

4.5.5. Simple XML Style

The Simple XML style:

4.5.6. Event Style

The Event style:
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5.1. Users

Recognized users are either Indico locally registered users, NICE users or users with CERN light weight
accounts.

5.2. Groups

Recognized groups are either Indico locally created groups (only administrators can create such groups),
NICE groups, or SIMBA lists. We strongly recommend the use of SIMBA lists as groups of users in
Indico.
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6.1. To Personal Scheduler Tools (Outlook, iCal,
korganizer...)

You can export an event or a set of events to your personal scheduler tool by using the Indico iCal export.

Everywhere you see this icon , click on it to export the content of the page you are on to your
scheduler tool.

On an event page, the event will be exported, on a category page, all events in the category will be
exported. Some scheduler tools recognise well multiple events (iCal, korganizer, Outlook 2007), others
don’t (Outlook 2003), in this case only the first event in the list is recognised.

You can also ask your personal scheduler tool to subscribe to one of these export URLs (this is
particularly interesting for the category export). For iCal: "Calendar" menu -> menu item "Suscribe",
then enter the URL of the ical export. Finally, set the "Refresh" to "Every day". Everyday, your iCal
software will update its content with any new event in the category.

6.2. RSS feeds

Indico provides RSS feeds on each category page. If your browser is RSS-aware, you will see an icon

like this on the browser menu bar: . Click on it to access the RSS feed, then possibly subscribe to
it using an RSS aggregator.

6.3. Sharepoint

If you maintain a sharepoint web site, it is very easy to create inside it a web part exposing the
forthcoming events from an Indico category. First add an XML web part, then in the “XML link” part,
add the XML export URL from indico (eg.
http://indico.cern.ch/tools/export.py?fid=2l12&date=today&days=1000&of=xml) and in the “XSL link”
part, add this URL: http://indico.cern.ch/export.xsl.

The result should look like this:
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6.4. Using the export.py script

Indico allow you to programmatically access the content of its database by exposing its events through a
web service, the export.py script.

A typical example of how to use this script is:

http://my.indico.server/tools/export.py?fid=2l12&date=today&days=1000&of=xml
where:
fid is the category from which you want to extract the events (can be a + separated list)
date is the starting date of the event (format: yyyy-mm-dd or today)
days is the number of days to export the events (starting on date)
of is the output format (one of xml, html, ical, rss)
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7.1. Introduction

This chapter describes Indico module for booking conference rooms.

Indico users can book conference rooms for their conference and meeting purposes. Bookings can be
also created standalone - they don’t have to be bound to any event. Room managers can monitor and
moderate all bookings. Indico administrators can create rooms and manage their data.

Instead of being a boring manual no one ever reads, this file is an introduction. This assumes you have an
intuition how the web works. The suggested way of learning is to start with a tutorial. Then play with the
module on your own. Simply use the software as any other web page. Read context help along the way.
Finally come back for some tips.

7.2. The Tutorial

You may want to read Core Features listing to grasp an idea of room booking module capabilities. To
summarize, it is for booking conference rooms.

7.2.1. Getting into Room Booking Module

To use Indico::CRBS directly, just click ’Room Booking’ on Indico home page. To book rooms for your
event, go to the event management page and click ’Room Booking’ tab. In both cases you will be asked
to sign in. Use your Indico credentials.
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7.2.2. The First Page

Room Booking Module first page depends on who is logged in. For most people, it will show list of their
bookings. ’Your bookings’ menu option will give you the same list. Room managers will see bookings of
rooms they manage, so they can quickly see what’s going on. If you are room manager, use ’Users
bookings’ menu option to show this page again. (This menu option is not visible for ordinary users).

7.2.3. The Most Important Tip

Feeling lost? Point at question mark icon with your mouse to see context help. Context help is meant
to answer most of your questions along the way. It is always there waiting for you.

7.2.4. Room Names

If room does not have a name, the default one is built according to the following pattern:

"location: building-floor-room"

Examples: "CERN: 304-1-001", "Sheraton: 0-34-013".

7.2.5. Three Kinds of Rooms

There are three kinds of rooms. They determine how much freedom users have.

• Public rooms, which do not require confirmation (black/green color). This means all bookings are
considered accepted.

• Public rooms, which do require confirmation (orange color). You can PRE-book them and wait for
acceptance or rejection.

• Private rooms: cannot be booked at all (red color). Only room manager can book his/her private room.
If you need such room, you should ask this person to insert a booking for you.
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7.2.6. Six Types of Bookings

There are six types of bookings. They allow you to define different types of recurring reservations.
Common example is weekly meeting (which takes place the same time every week). You can choose
from:

• ’Single day’ : not recurring, one time event

• ’Repeat daily’ : use if you want to book many subsequent days, like the whole week

• ’Repeat once a week’ : the booking will take place every week, always the same day

• ’Repeat once every two weeks’ : like above, but repeats every two weeks

• ’Repeat once every three weeks’ : like above, but repeats every three weeks

• ’Repeat every month’ : allows you to do bookings like ’first Friday of each month’, ’second
Wednesday of each month’, ’fourth Saturday of each month’, etc.

7.2.7. Booking a Room

Basically there are two steps: selecting a room and filling a booking form. More detailed steps are:
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• On main Indico page, click ’Room Booking’ main menu option. This is your entrance to Room
Booking Module.

• Click ’Book a Room’ menu option.

• If you know which room you want, simply select it and click [Choose]. You will be taken directly to
the booking form.

• If you don’t know, take advantage of room searching. Specify dates (click orange calendar icon to
choose day with a mouse). Specify hours and booking type (single day or repeating). Specify also
other criteria the room must meet, like capacity and necessary equipment. Then click [Search] button
(there are two for convenience, both will do the same).

• You will be presented a list of available rooms meeting your criteria.

• Click ’book’ link on for the room of your choice.
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• Fill a booking form. If you have searched for rooms, most fields are already filled for your
convenience. These data come from searching form. After filling the form, click [Re-check for
conflicts] button.

• Scroll page down to have a look on conflicts. Scroll more to see room availability calendar. Your
booking is represented by green bar... or dark red bar if it overlaps on existing bookings, which are
pink, by the way. This graphical room preview is useful mainly when you do a recurring booking.
Give it a try: set when/type attribute to ’Repeat once a week’, set end date to be at least 2 months after
start date, and click [Re-check for conflicts] again. See room calendar in it’s full glory.

• If your booking conflicts with others, you have two options:

• In general, you will prefer to resolve conflicts manually - by changing dates, hours or maybe trying
another room.

• The alternative is to automatically book everything except conflicting days. This may be useful if
you do long-term, repeating booking, for example ’whole year, every week’. Imagine everything
looks perfect, except for several weeks when room is not available. In this case check the ’skip
conflicting dates’ option to book everything except problematic dates.

• Click [Book] button.

• If your form is OK, system will ensure your new booking does not conflict with others. When no
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conflicts are found, you will be shown confirmation page which enlists details of your booking.

• Click ’Your bookings’ from menu. Your new booking now appears on the list.

Note: some rooms require confirmation. These rooms often appear in orange color. In this case, you
cannot directly book them. You can only ’PRE-book’ such room. PRE-booking works exactly the same
way as booking. The only difference is that you must wait for acceptance from room manager.

Note: you can always modify your booking (or PRE-booking). It will be again checked for conflicts.

Note: you can always browse your own bookings and PRE-bookings using menu options ’Your
bookings’ and ’Your PRE-bookings’.
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7.3. Core Features and Constraints

7.3.1. Introduction

This section describes core capabilities and constraints of Room Booking Module. It may be useful to
assess whether it meets your needs.

Note that Room Booking Module is NOT supposed to be a general purpose "room management" or
"room booking" software.

It was built with _conference_ rooms in mind. Its main purpose is to make conference organization
easier. We see room booking as a part of conference organization. (But you _can_ book rooms without
defining an event).

7.3.2. Core Features

7.3.2.1. General

• Standalone and "in-conference" mode.

• Standalone mode allows you to book, manage bookings and do administration stuff. You don’t have
to create Indico event. (Bookings will not be assigned to any Indico event).

• "In-conference" mode allows you to book rooms for your event. You can assign booked room to
conference, lecture, meeting, session, contribution or break.

• Repeating bookings (’every day’, ’every week’, ’every 3rd Wednesday of a month’, etc).

• E-mail notifications (to users and room managers, about every important action).

• Three user roles: (1) Indico administrator, (2) room manager and (3) ordinary user.

• Optional booking moderation. Each room may work in one of the following modes:

• Bookings require explicit confirmation of room manager, or

• Bookings are automatically accepted

7.3.2.2. User

• Book a room

• Manage own bookings (track, modify, cancel)

• Search for rooms
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• Search for bookings (including archival)

7.3.2.3. Room Manager

• Accept and reject PRE-bookings (for his room)

• Reject bookings (for his room)

7.3.2.4. Indico Administrator

• Switch on/off Room Booking Module

• Configure room booking plugins in admin section

• Add/remove location

• Define room attributes specific to the location

• Define possible room equipment specific to the location

• Manage meeting rooms (add/modify/remove)

7.3.3. Constraints

The room must have its manager. It is not possible to define multiple managers for a single room. (You
can workaround this by creating Indico account shared by several people).

The room must have defined its building, which must be a number. This is mandatory. If you don’t need
building, put any number there (like ’0’). If your buiding naming scheme have letters, we are sorry - the
software is not flexible enough for you.

The room must have defined floor (alphanumerical) and room ’number’ (alphanumerical in fact).

7.4. Dictionary

Room : meeting or conference room. Please note that software is not suitable to manage other rooms, like
offices, corridors, etc.

Location : physicall location of rooms. Room custom attributes and possible equipment are defined on
location basis. Example: rooms at CERN may have different attributes and different equipment than
rooms in Fermilab.
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Booking : final reservation of a room. While considered final, it still may be rejected in case of
emergency.

PRE-booking : not confirmed reservation of a room. PRE-booking is subject to acceptation or rejection.

Room responsible : the person who accepts / rejects bookings. Each room has exactly one person
responsible. A person may be responsible for any number of rooms.

Room manager : room responsible
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8.1. Introduction

With this evaluation module for Indico you can create your own online web survey in order to know
participants’ opinion about conferences/seminars/lectures.

8.2. Functional goals

8.2.1. Security

Survey questions and statistical results are neither vital nor confidential for CERN members. We believe
standard precautions are enough within this application. A survey will inherit access and modification
rights from the event it belongs to. In other words only users who are allowed to see an event will be able
to have access and fill in the evaluation form. The survey can only be altered in the management area.
This means that only users who are already allowed to edit an event can modify the corresponding survey
and view the statistical results.

8.2.2. Usability

Main possible actions for the surveyor (management area) are the following:

• Create/edit an evaluation form concerning an event.

• Edit its options and status (visible/hidden).

• Possibility of setting that only logged users have access to the form.

• Create/edit questions contained in this form.

• Ability to preview a form while editing it.

• Import/export an evaluation in order to back it up or facilitate further creations.

• See the statistics of the results.

• Export statistics to a CSV file.

• Possibility of seeing/deleting individual answers in the results.

• Ability to send automatically the evaluation link by email to the participants when it starts.

• Possibility of editing a processing survey even if some people have already answered it.

For a submitter (display area):
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• Access to the survey via the menu of an event.

• Logged users can always modify their already submitted forms.

8.3. Interface

8.3.1. Management area

The evaluation module is a special feature and is by default deactivated at the beginning. So first of all if
you plan to use it, activate this feature by clicking on . Now you can see a new tab called Evaluation
on the top of the frame.

Then in Evaluation tab we have four sections: Setup | Edit | Preview | Results.

8.3.1.1. Setup

In this section you can set main information and configuration about the survey. Click on to
set your options.
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• Curent status: When an evaluation is HIDDEN (default), it is not shown in the Display Area and
guests cannot answer it. On the other hand, it is shown if set to VISIBLE. But be aware if you want
your survey to be well running that it must be open and contain some questions. To show / hide it,
simply click on / .

• Notifications: You can set email addresses of people you want to be notified when the evaluation
starts and/or when someone answers the form. Advice: In the modification panel, check
Add current registrants if you want your event participants to be notified of the starting evaluation.

• Must have an account: If an account is needed, visitors must first login before accessing the form.

• Anonymous: When anonymous, logged submitters send their form anonymously. Otherwise their
identity is known by the surveyor. Note: Users not logged in can always send their form anonymously.
If you really need to know the identity of all your submitters, you have to check Must have an account.
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• Special Actions:

• Export the evaluation with its questions to an XML file. Useful for backing
up or transporting. Note: If the file is directly shown in Firefox/InternetExplorer6, save it with: File
> Save as... To solve the same problem in InternetExplorer7: Page > Save as...

• Import an evaluation from an XML file.

Concerning main setup configuration (all main information, e.g. title, announcement, ...) you can
choose to keep your current one or to overwrite it with imported one. For the questions, you can
keep only your current ones or only imported ones or have both (imported ones just after current
ones). Advice: We suggest you to back up your current evaluation (with export feature) before
importing in order to prevent losses of data. Notes: In order to prevent some misunderstanding the
status and the dates are not imported. Be aware that as questions and submissions are bound, you
will also lose your current submissions if you get rid of your questions.

• All collected answers will be erased.

• All questions will be erased. As the submissions are connected to them,
they will also be removed!

• Delete all evaluation informations, its questions and its submissions. You
will have a brand new evaluation.

8.3.1.2. Edit

In this section you can add/edit/remove the questions of your form. On the left panel you have 6 different
types of question you can add.
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• Textbox: A standard field where your submitter can enter some text as answer is provided with the
question. Here is a little example of a question of type Textbox.

• Textarea: Like Textbox but with more capacity for text. Suited for long answers like comments,
feedbacks, etc.

• Password: Like Textbox but the answer is hidden. For example on the picture below, it is
recommanded that the answer is hidden if the submitter is in a public area. Otherwise anybody next to
him would be able to read the password on the screen. Note that the evaluation module doesn’t use
https, as all this information is not supposed to be confidential.

• Select: A drop down list which lets the submitter to select one answer.

• Radio: A group of radio buttons which lets the submitter to select one answer.

• Checkbox: This type is suited for multiple choices questions. You can check many answers.
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When adding a Textbox/Textarea/Password you have the above screen.

• Required: If checked, an answer for this question is mandatory.

• Question: Enter your question.

• Keyword: A keyword is the summary of the question in one word. (e.g. "What is your name?" ->
"name") It’s useful when exporting the statistics into a CSV file. Instead of writing the full question,
we just write the keyword so that it takes less place.

• Description: Enter a description (facultative).

• Help: Enter a help message (facultative).

• Default answer: The answer of the question will already be filled with this given default answer
(facultative).

• Position in form: The position of the question within the form.

On the following picture you can see the result of the manipulation.
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When adding a Select/Radio/Checkbox you have the above screen. Note that some fields have already
been described above, that’s why they are not explained here.

• Choice Items: Choice items are selectionable answers. Note: Check the box next to an choice item, to
set it to be a default answer.

On the following picture you can see the result of the manipulation.
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After having first added some questions, here is an example of the questions overview (see above
picture). You can change the position of a question within the form by clicking on . Press to
edit a question and to remove it.

8.3.1.3. Preview

In Preview you can see how your evaluation really looks like in the display area. Feel free to play with
this form, submitted information won’t be recorded.

8.3.1.4. Results

In this section we have the statistics. There are two panels called Options and Statistics.
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In the first one you can select which submissions you want to see, remove some of them and export all
the results into a CSV file.

To import a CSV file into Microsoft Office Excel: Data > Import External Data > Import Data... > select
your CSV file > Next > Uncheck Tab and check Comma > Next > Finish > OK.

In the second, you see the recolted results of your evaluation shown as graphs or as answers lists
depending on the question type.

Answers lists shown for Textbox/Textarea/Password. (See Section 8.3.1.2)

Graphs shown for Select/Radio/Checkbox. (See Section 8.3.1.2)
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8.3.2. Display area

For a conference, you can access an evaluation via the left menu.

For a meeting/lecture, you can access it via the top menu.

107



Chapter 9. Protection System

9.1. Introduction

This section aims to describe the protection system used by Indico to grant or restrict access to users.

9.2. Basic concepts

9.2.1. Inheritance schema

You can setup a protection policy for almost all the objects that you can create within Indico. This
protection policy is based in an inheritance system, meaning that an object is going to inherit the
protection from its father, e.g. a contribution can be public but becomes private if we setup its container
(a meeting) as private.

The protection objects tree is as shown in the following picture:
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As we can see, a File inherits the protection policy from Material, Material from Contribution,
Contribution from Session, Session from Event, Event from Subcategory and Subcategory from Category.

The next picture shows an example of this inheritance system. "Category A" is PRIVATE and because of
this, "Conference 1" becomes PRIVATE too. As User 1 and User 2 are in the access list for "Category A"
they can also access "Conferece 1". The rest of Indico users cannot access "Category A" and
"Conference 1".
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9.2.2. Protection types

For each object (category, conference, contribution, session, etc) in Indico, one can setup three kinds of
protection: modification control list, access control setup and domain control.

• Modification control list contains all the users or groups that can edit and modify an object. Therefore,
people in this list will be the managers for the object and they can access all the pages related to it and
the objects under it.

• Access control setup: by default, an object is public but we can make it private and add restrictions as
shown in the section "Access control policy"

• Domain control: one can protect an Indico object to be accessed just from users who are connected
from some given IPs (see "Domain control policy")

9.3. Access control policy

By default, all the objects (category, event, session, contribution, material, file and link) in Indico are
PUBLIC.
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We can set an object as PRIVATE and this means that all the objects under it will be PRIVATE as well.

If an object is PRIVATE, nobody can access it but the managers, the users/groups in the access list
named "Users allowed to access" and those who know the "access key" if set.

If an object is PRIVATE by inheritance:

• Nobody can access it but the managers and the users/groups in the access list "Users allowed to
access" of its father (as example, see section "Inheritance Schema").

• We can set the PRIVATE object as PRIVATE by itself, which means that Indico checks only its
protection policy and not the father’s protection policy.

In the graphic, "User 1" and "User 2" can access "Category A" but they cannot access "Conference 1".
Just "User 3" can access "Conference 1".

• We can set the PRIVATE object as ABSOLUTELY PUBLIC, which means that Indico skips the
protection that was establish by inheritance.
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In the graphic, just "User 1" and "User 2" can access "Category A" but everybodoy can access
"Conference 1".

9.4. Domain control policy

If an Indico object (category, event, session, contribution, material, file and link) is PUBLIC, we can
restrict the access to users accessing Indico from some given IPs (these IPs could be like 127.1 which
means that every IP starting like this will be valid).

If the Indico object is PRIVATE, this checking will not be applied.

If you wish to add special access to some users, meaning that the domain control will not be applied for
those users, you can add them in the "Users allowed to access" list.

112


	Indico User Guide
	Table of Contents
	Chapter 1. Categories
	1.1. Category
	1.2. Creating a Category
	1.3. Category Management Area
	1.3.1. Main
	1.3.2. Access Control
	1.3.3. Conference Creation Tool
	1.3.4. Detail Modification & SubCategory/Event Organisation
	1.3.5. Deleting a Category


	Chapter 2. Conferences
	2.1. Conference
	2.2. Creating a Conference
	2.3. Setting up a Conference
	2.4. Conference Management Area
	2.4.1. Main Management
	2.4.2. Program Management
	2.4.2.1. Tracks

	2.4.3. Contribution Management
	2.4.3.1. Contributions
	2.4.3.2. Sub Contributions
	2.4.3.3. Material

	2.4.4. Abstracts Management
	2.4.4.1. Calling for Abstracts
	2.4.4.1.1. Notification Template

	2.4.4.2. Abstracts Tab
	2.4.4.3. Abstracts
	2.4.4.4. Book of Abstracts

	2.4.5. Timetable Management
	2.4.5.1. Sessions
	2.4.5.2. Adding Sessions and Breaks to Timetable
	2.4.5.3. Adding Contributions to Timetable
	2.4.5.4. Session Management
	2.4.5.4.1. Slots
	2.4.5.4.2. Main Tab
	2.4.5.4.3. Contributions Tab
	2.4.5.4.4. Access Control
	2.4.5.4.5. Tools Tab
	2.4.5.4.6. Adding Slots to Session
	2.4.5.4.7. Adding Contributions to Sessions


	2.4.6. Access Control Management
	2.4.7. Registration Management
	2.4.7.1. Registration Form
	2.4.7.1.1. Reason for Participation
	2.4.7.1.2. Sessions
	2.4.7.1.3. Accommodation
	2.4.7.1.4. Social Events
	2.4.7.1.5. Further Information

	2.4.7.2. Registrants

	2.4.8. Display Management
	2.4.8.1. Display Menu Customisation
	2.4.8.2. Colour Customisation
	2.4.8.3. Logo Customisation

	2.4.9. Conference Tools
	2.4.9.1. Deleting a Conference
	2.4.9.2. Cloning a Conference
	2.4.9.3. Packaging Material
	2.4.9.4. Create an Offline version of a Conference
	2.4.9.5. Alarm Control


	2.5. Conference Display Area
	2.5.1. Navigating the Conference Display Area
	2.5.2. Overview Area
	2.5.3. Calling for Abstracts Area
	2.5.3.1. Submitting an Abstract
	2.5.3.2. Viewing your abstracts
	2.5.3.3. Abstract Display

	2.5.4. Author Index
	2.5.4.1. Author Display

	2.5.5. Contribution Area
	2.5.5.1. Contribution Display
	2.5.5.1.1. Contribution Material Display


	2.5.6. My Conference Area
	2.5.6.1. My Conference Session Coordination

	2.5.7. Registration Area
	2.5.7.1. New Registrant

	2.5.8. Book of Abstracts
	2.5.9. Scientific Programme Area
	2.5.10. Timetable Area
	2.5.10.1. Session View



	Chapter 3. Meetings
	3.1. Meeting
	3.2. Creating a Meeting
	3.3. Meeting Management Area
	3.3.1. Main Management
	3.3.1.1. Meeting Visibility

	3.3.2. Timetable Management
	3.3.2.1. Adding Contributions
	3.3.2.2. Adding a Session
	3.3.2.3. Session Management
	3.3.2.3.1. Adding Slots to Sessions
	3.3.2.3.2. Adding Contributions to Sessions/Slots
	3.3.2.3.3. Editing Slots

	3.3.2.4. Contribution Management
	3.3.2.4.1. Main Tab
	3.3.2.4.2. Sub Contribution Tab
	3.3.2.4.3. Access Control Tab
	3.3.2.4.4. Tools Tab
	3.3.2.4.5. Sub Contributions
	3.3.2.4.6. Material in Contributions


	3.3.3. Access Control Management
	3.3.4. Tools Management
	3.3.4.1. Deleting a Meeting
	3.3.4.2. Cloning a Meeting
	3.3.4.3. Packaging Material
	3.3.4.4. Create an Offline version of a Meeting
	3.3.4.5. Alarm Control


	3.4. Meeting Management Displays
	3.4.1. Material Display
	3.4.2. Session Display
	3.4.3. Contribution Display
	3.4.4. SubContribution Display

	3.5. Meeting Display Area
	3.5.1. Indico Style
	3.5.2. IT Style
	3.5.3. Simple Text Style
	3.5.4. Administrative Style
	3.5.5. Compact Style
	3.5.6. Parellel Style


	Chapter 4. Lectures
	4.1. Lecture
	4.2. Creating a Lecture
	4.3. Lecture Management Area
	4.3.1. Main Management
	4.3.1.1. Material

	4.3.2. Access Control Management
	4.3.3. Tools Management
	4.3.3.1. Deleting a Lecture
	4.3.3.2. Cloning a Lecture
	4.3.3.3. Packaging Material
	4.3.3.4. Create an Offline version of a Lecture
	4.3.3.5. Alarm Control


	4.4. Lecture Management Displays
	4.4.1. Material Display

	4.5. Lecture Display Area
	4.5.1. Lecture Style
	4.5.2. IT Style
	4.5.3. CDS Agenda Style
	4.5.4. Static Style
	4.5.5. Simple XML Style
	4.5.6. Event Style


	Chapter 5. Users and Groups
	5.1. Users
	5.2. Groups

	Chapter 6. Exporting Indico Data
	6.1. To Personal Scheduler Tools (Outlook, iCal, korganizer...)
	6.2. RSS feeds
	6.3. Sharepoint
	6.4. Using the export.py script

	Chapter 7. Conference Room Booking
	7.1. Introduction
	7.2. The Tutorial
	7.2.1. Getting into Room Booking Module
	7.2.2. The First Page
	7.2.3. The Most Important Tip
	7.2.4. Room Names
	7.2.5. Three Kinds of Rooms
	7.2.6. Six Types of Bookings
	7.2.7. Booking a Room

	7.3. Core Features and Constraints
	7.3.1. Introduction
	7.3.2. Core Features
	7.3.2.1. General
	7.3.2.2. User
	7.3.2.3. Room Manager
	7.3.2.4. Indico Administrator

	7.3.3. Constraints

	7.4. Dictionary

	Chapter 8. Event evaluation
	8.1. Introduction
	8.2. Functional goals
	8.2.1. Security
	8.2.2. Usability

	8.3. Interface
	8.3.1. Management area
	8.3.1.1. Setup
	8.3.1.2. Edit
	8.3.1.3. Preview
	8.3.1.4. Results

	8.3.2. Display area


	Chapter 9. Protection System
	9.1. Introduction
	9.2. Basic concepts
	9.2.1. Inheritance schema
	9.2.2. Protection types

	9.3. Access control policy
	9.4. Domain control policy


